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Congratulations on purchasing a broadband 
modem by Novatel Wireless 

This Modem operates over high-speed networks enabling you to 
connect at high speeds to the Internet or your corporate Intranet, 
and access your email while you are away from the office. 

Patents and licenses 
Licensed by QUALCOMM Incorporated under one or more of the 
following Patents:
4,901,307	 5,490,165	 5,056,109
5,504,773	 5,101,501
5,506,865	 5,109,390	 5,511,073
5,228,054	 5,535,239
5,267,261	 5,544,196	 5,267,262
5,568,483	 5,337,338
5,600,754	 5,414,796	 5,657,420
5,416,797	 5,659,569
5,710,784	 5,778,338

Software License 

Proprietary Rights Provisions: 
The software drivers provided with this product are copyrighted 
by Novatel Wireless and/or Novatel Wireless’ suppliers. Although 
copyrighted, the software drivers are unpublished and embody 
valuable trade secrets proprietary to Novatel Wireless and/or 
Novatel Wireless’ suppliers. The disassembly, decompilation, and/
or reverse engineering of the software drivers for any purpose is 
strictly prohibited by international law. The copying of the software 
drivers, except for a reasonable number of back-up copies is strictly 
prohibited by international law. It is forbidden by international 
law to provide access to the software drivers to any person for any 
purpose other than processing the internal data for the intended 
use of the software drivers.



U. S. Government Restricted Rights Clause 
The software drivers are classified as “Commercial Computing de-
vice Software” and the U.S. Government is acquiring only “Restrict-
ed Rights” in the software drivers and their Documentation. U.S. 
Government Export Administration Act Compliance Clause: 

It is forbidden by US law to export, license or otherwise transfer 
the software drivers or Derivative Works to any country where such 
transfer is prohibited by the United States Export Administration 
Act, or any successor legislation, or in violation of the laws of any 
other country. 

Please visit www.novatelwireless.com for the latest information 
about your device.

http://www.novatelwireless.com
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About this Guide 
Thank you for choosing Novatel Wireless and welcome to the 
MobiLink 3 User Guide for Windows. The MobiLink software works 
with your Broadband Modem to enable you to connect at high 
speeds to the Internet, your corporate Intranet, and your email 
while you’re away from the office. 

This User Guide outlines the features and use of the MobiLink 
software. 

Configure and Connect – This chapter provides instructions 
for managing and configuring your Internet connection and 
using the features of the MobiLink software. 

SMS Messaging – This chapter provides more detailed infor-
mation on using the SMS client in your software.

Troubleshooting – This chapter provides troubleshooting 
information for your MobiLink software.

Glossary 
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Configure 
& Connect

Overview
Using the MobiLink Connection Manager

Using the system tray icon
Using the MobiLink menus
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Overview 
When you attach your Modem the first time, the MobiLink 
software is installed automatically.

The MobiLink shortcut is placed on the desktop and an icon 
appears in the system tray.

                    

The system tray icon provides status and settings information 
while the desktop shortcut icon launches the MobiLink software.

Using the MobiLink Connection Manager
Right-click the system tray icon and select Open Connection Manager to 
open the Connection Manager.

If the system tray icon is not present, double-click the desktop 
shortcut to launch the software.

If you would like the software to run whenever Windows is started, 
make sure that Auto-Launch is checked. See “Settings” on page 10.



4

Configuration & Managing Connectivity 

1. Close button Click to close the Connection Manager. The 
MobiLink continues to run and the icon is 
available in the system tray.

2. SMS Received Envelope icon shows that you have received 
an SMS message.

3. Connection Status Displays your connection status, which may 
include:  Connected, Disconnected, Ready, 
and No Device Detected.

4. Signal Strength More bars indicate a stronger connection.

5. Network Technology The type of network that you are on: EVDO 
or Edge..

6. Connect/Disconnect button Click this button to connect or disconnect 
from the network.

7. Bytes In 
8. Bytes Out

The number of bytes sent and received in 
this session.
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Configuration & Managing Connectivity

9. Duration How long the network has been connected.

10. Roaming This indicator appears when you are 
Roaming.

11. Menu button Click to access the MobiLink menus.
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Managing Connectivity from the Connection 
Manager
1.	 Right-click the system tray icon and select Open Connection Manager. 

2.	 Click the Connect or Disconnect button.

NOTE: If the status reads No Device Detected, be sure that your modem is 
properly connected to your computer.
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Using the system tray icon 
You can manage your connectivity, assess system status, and 
access the menus all from the system tray icon. The system tray is 
the area in the lower right part of your screen where the clock is 
located.

The MobiLink icon appears in the system tray when the software is 
running. 

Tip: 

You can tell the status of the network connection simply by 
glancing at the icon.

No device is attached to the computer.

A device is attached and ready to be connected.

The network connection is active.

Hover the cursor over the MobiLink system tray icon to have a 
status bubble pop up.

If the icon is not in the system tray, double-click the desktop shortcut or go 
to Start → Programs → Novatel Wireless → MobiLink → MobiLink to start the 
software.
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Managing Connectivity from the MobiLink 
System Tray icon
1.	 Right-click the MobiLink system tray icon to see the menu.

2.	 Select Connect or Disconnect from the menu.
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Using the MobiLink menus
You can access the MobiLink menus in two ways.

Click the Menu button on the 
Connection Manager window.

Right-click the MobiLink system 
tray icon.
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Settings
The Settings submenu allows you to configure MobiLink to meet 
your needs. From this menu you can do the following:

•	 Create additional profiles, including VPNs (virtual private 
networks)

•	 View your connection history

•	 Set up and manage a PIN code for security

•	 Set the software to auto-launch whenever Windows is started
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Profile Manager
The Profile Manager wizard allows you to change your network 
profile settings. Here you may create new profiles or update 
existing ones. For example, you can create a new profile for a VPN 
or update an existing profile with new username or password 
settings.

NOTE: 
HSPA network profiles may have different options.
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To add a new profile

1.	 Click New to start the Profile Manager wizard.

2.	 Enter a simple name for the new profile (for example, My 
Connection). 

3.	 CDMA/EVDO Networks:  Select the Connection Type and click Next.

GSM/HSPA Networks:  Enter the Access Point Name (APN) that 
you received from your provider.
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4.	 If your profile is for a VPN or requires manual TCP/IP settings, 
click Advanced and enter the needed settings.

5.	 Enter a user name and password for this profile and click Finish.
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To edit or update a Profile:

1.	 From the Profile Manager main menu, select the profile you 
want to update and click Edit.

2.	 Enter the appropriate information, click Apply and then OK.
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Connection Log
The connection log gives you statistical information about your 
network connection.
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Configuration
The Configuration menu allows you to require a PIN code to access 
the modem. Use the Miscellaneous tab to turn on a roaming alarm.

To require a PIN or Lock code

Use this setting to secure your cellular connections.

1.	 Select Configuration from the Settings menu.

2.	 Click the Mobile tab.

3.	 Click Change Pin Code.

4.	 Enter your current PIN code and the new one. The length of the 
PIN code will depend on your service provider.
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5.	 Click OK twice.

NOTE: 

6.	 AutoLock on powerup.

To set the roaming alarm

1.	 Select Configuration from the Settings menu.

2.	 Click the Miscellaneous tab.

3.	 Click the Show Roaming Alarm check box.

Now when you are roaming, the Roaming icon  will appear on 
the Connection Manager.

Auto-Install
Checked by default, this option  indicates that MobiLink was set 
to install the drivers and the MobiLink software on your computer 
automatically.

Auto-Launch
Checked by default, this option indicates that MobiLink is set to 
launch when your computer is started.

To disable the AutoLock, delete the PIN code fromthe Pin Code box and 
then deselect the check box.
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Languages
To view and experience MobiLink in another language, open the 
Menu, select Languages then the language of your choice.

Activation
This item is found only on CDMA networks and is dependent on 
your Service Provider. If activation is required by your provider, 
instructions should have been provided with your wireless 
modem. If you are unable to locate them, contact your Service 
Provider directly.

To activate your product, open the Menu, select Activation, then fill 
in the information provided by your Service Provider.

Device Properties
To obtain specific details for your device, such as the assigned ESN 
or Mobile Number, open the Menu and select Device Properties.
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SMS Client
Your broadband modem and MobiLink software provide a built-in 
SMS Client. For more detailed information, see “SMS 
messaging” on page 26.

1.	 Open the Menu and select SMS Client.

2.	 To send an SMS message, click the New SMS Message button.
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3.	 Compose your message and click Send.
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Address Book
Your broadband modem and MobiLink software provide access 
to the Windows Address Book. You can use the Address Book in 
conjunction with SMS Messaging. For more information, see  “SMS 
messaging” on page 26.

1.	 Open the Menu and select Address Book.

You can view names from the Windows Address Book, Global 
Group Contacts, or the Mobile contacts list.
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2.	 To add a name to the Address Book, click the New Entry button.
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3.	 Fill in the information and click OK and OK again.
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GPS
Your broadband modem and MobiLink software work together to 
provide you with GPS information and direct access to map sites.

1.	 Open the Menu and select GPS.

The system immediately begins finding your location.

2.	 Click Launch Map Site to launch the Internet map site of your 
choice.

3.	 Click Settings to set the default GPS Mode and Map Site.

Select the GPS Mode and Map Site and click OK.
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About
Open the Menu and select About to review the details about the 
software version of MobiLink that you are using.
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SMS  
messaging

Overview
Compose and  Send Messages

Use the Format Menu
Select Recipients from your Address Book

Send an SMS Message from the Address Book
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Overview
SMS (Short Message Service) enables you to send and receive short 
text messages to and from mobile devices. The MobiLink software 
includes an easy-to-use application for sending and receiving SMS 
messages. 

To open the SMS Client window

•	 Right-click on the MobiLink icon in the system tray and select 
SMS Client.

The SMS window is similar to an email client window and contains 
an Inbox, Outbox, and a Sent messages box. In addition there is 
a window that will show a list of your received messages with a 
reading pane underneath.



28

Compose and Send Messages
To compose an SMS message

1.	 Right-click on the MobiLink icon in the system tray and select 
SMS Client. 

2.	 On the SMS Client toolbar, click the New SMS Message button. 
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3.	 In the Compose Message window, specify recipients for the 
message using either of the following methods: 

•	 In the To... box, type the phone number or email address of 
each recipient, separating names with a semicolon (;). 

•	 Click the To... button and select one or more recipients 
from the Select Recipients dialog as described in Selecting 
Recipients From Your Address Book. 

4.	 Type your phone number in the Callback: box. (CDMA/EVDO 
networks only.)

5.	 To set the importance of the message, click the green 
exclamation point (!) for Urgent or the red exclamation point (!)
for Emergency. See Using the Format menu to change encoding, 
request a receipt, or set priority using a menu.

6.	 Type the text of your message in the text entry area. As you type 
your message, the current character count is displayed at the 
bottom of the window.  

7.	 To send the message, click the Send button. 

NOTE: SMS Messaging charges and character limit are network operator dependent. 
Contact your network operator for details.
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Use the Format menu
Use the Format menu to set message encoding, set the message 
priority, request a receipt, and set the current configuration as the 
default for future messages.

The MobiLink software allows you to send messages encoded in 
ASCII, Unicode, or Latin-1 formats. 

Priority can be set as Normal, Urgent, or Emergency.

Select Receipt (a checkmark will display next to it) to request a 
receipt when the recipient reads your message.

Select Set Default to establish the current set of choices as your new 
default for future messages.

Select Recipients from Your Address Book
1.	 In the Compose Message dialog, click the To… button. 

2.	 In the Name list of the Select Recipients dialog, select the name 
of a recipient and click the Mobile-> button to move it into the 
Message Recipients box. 

3.	 To create a new entry in the currently selected address book, 
click New Entry…. In the Contact dialog, enter a name and mobile 
number and click OK. 

4.	 To view or edit information any name in the phone book, click 
on the name in the address list and click Edit. When you have 
finished viewing or editing the contact information, click OK to 
close the Contact dialog. 
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5.	 Click OK. The names and numbers you have selected are entered 
as recipients for your message. 

Send an SMS message from the Address Book
You can initiate your SMS message from the Address Book.

1.	 From the menu select Address Book

2.	 Select the recipient.

3.	 Click the Send SMS button.

4.	 The Compose window will launch for you to compose and send 
your message.
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Troubleshooting
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Troubleshooting

Why do I see the message “No ‘device’ detected” 
when I run MobiLink
Your modem was not inserted properly into your computer. 

1.	 Exit MobiLink.

2.	 Remove your device.

3.	 Restart your computer.

4.	 Restart MobiLInk.

5.	 Reinsert your device.

Why do I see the message “SIM not found” when I 
run MobiLink?
Your SIM card uses contact points to connect with your device. 
Take care not to touch or damage the contact points. Use the 
orientation notch as a guide to properly insert the SIM.

Why does the LED flash red?
This happens when your SIM card is locked. Enter your PIN code 
when prompted. If you enter the wrong PIN code 3 times, you will 
be prompted to enter your PUK code. If you enter the wrong PUK 
code 10 times, your SIM card will be locked forever. Contact your 
mobile operator to obtain a new SIM card.

Why does the message “Searching for network” 
display continuously when I run MobiLink?
You are outside of the coverage area. Contact your mobile operator 
to find out more about coverage areas.
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Why can’t I connect to the network?
Check the user name, password and access point name (APN) 
(HSPA networks) or Connection Type (CDMA networks) in your 
connection profile . If any of these entries are wrong, you won’t be 
able to connect to the network.

Why can’t I browse the web?
Check your server settings.

1.	 Start Internet Explorer.

2.	 Click on the Tools menu, and select Internet Options.

3.	 Click the Connections tab

4.	 Under Dial-up and Virtual Private Network settings, double-click the 
name of your connnection (for example, 3G Connection).

This field name will vary, depending on your service provider.

5.	 Check your Username and Password:

6.	 If you are using a proxy server, select the appropriate boxes.

7.	 Click OK twice to finish.
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Glossary
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Glossary 

1xRTT 
Short for single carrier (1x) Radio Transmission Technology. A high 
speed wireless technology based on the CDMA platform. 1xRTT 
has the capability of providing broadband-like speeds of up to 144 
Kbps.  1xRTT is also referred to as CDMA2000. 

1xEVDO 
Part of a family of CDMA2000 1x digital wireless standards. 1xEVDO 
is a “3G” standard. EVDO stands for “EVolution, Data-Optimized.” 
1xEVDO is based on a technology initially known as “HDR” 
(High Data Rate) or “HRPD” (High Rate Packet Data), developed 
by Qualcomm. The international standard is known as IS-856.  
1xEVDO has the capability of providing broadband-like speeds of 
average speeds of 400-700 kbps.  

bps 
Bits per second – rate of data flow. 

Broadband 
High-capacity high-speed, transmission channel with a wider 
bandwidth than conventional modem lines. Broadband channels 
can carry video, voice, and data simultaneously. 

Firewall 
A hardware or software boundary that protects a network or single 
computer from unwanted outside traffic. 

HSDPA
High Speed Downlink Packet Access. HSDPA is an enhanced 
version of WCDMA that supports broadband connections with 
download speeds up to 7.2 Mbps. This enhanced 3G technology 
enables the download of high-bandwidth multimedia files, high 
resolution graphics, and other complex files, and viewing email 
attachments at broadband-like speeds.

Glossary: A-F
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Hot-Swappable 
The ability to remove and replace the microSD Card from a device 
while it is still connected to the computer and online without 
damaging the device. 

IP 
Internet Protocol. The mechanism by which packets are routed 
between computers on a network. 

ISP 
Internet Service Provider. Also referred to as the service carrier, an 
ISP provides Internet connection service. 

Kbps 
Kilobits per second – rate of data flow 

LAN 
Local Area Network.  A data network confined to limited area with 
moderate to high data rates. Does not use common carrier circuits, 
although may have gateways or bridges to other public or private 
networks. 

Mbps 
Megabits per second 

MicroSD 
Additional external memory for devices with that capability. 

MicroSD Card 
A small, removable flash memory card available in various storage 
sizes. This accessory is sold separately. 

MicroSD Slot 
A built-in slot on some devices that is designed specifically for a 
microSD Card. 

Glossary: H-M
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PDA 
Personal Digital Assistant. A handheld device used for 
organization, notes, address books, etc. 

PPP 
Point to Point Protocol. A method of connecting a computer to the 
Internet. 

Proxy 
A firewall mechanism that replaces the IP address of a host on the 
internal (protected) network with its own IP address for all traffic 
passing through it. 

Rev A 
CDMA EV-DO Rev. A is a leading-edge wireless technology with 
higher data rates and higher system capacity. It is a fully backward 
compatible standard and remains interoperable with deployed 
EV-DO networks and devices around the world. The increased 
data rates on Rev. A’s physical layer enable richer applications and 
services. For more information, visit www.cdg.org. 

SMS 
Short Messaging Service.  Short text messages of generally no 
more than 140-160 characters sent and received by wireless 
devices. 

TCP/IP 
Transmission Control Protocol/Internet Protocol. A protocol for 
communicating over the Internet. 

Type A USB 
The USB ports on computers and hubs have a rectangular Type 
A socket, and peripheral devices have a cable with a Type A plug. 
Peripherals that do not have an attached cable have a square Type 
B socket on the device and a separate cable with a Type A and Type 
B plug.

Glossary: P-T

http://www.cdg.org
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USB 
Universal Serial Bus. A connection type for computing device 
peripherals such as a printer, mobile USB727 Modem, etc. 

VPN 
Virtual Private Network. A way to communicate through a 
dedicated server securely to a corporate network over the Internet. 

WAN / WWAN 
Wide Area Network (WAN). A computer network covering a broad 
geographical area. WANs are used to connect local area networks 
(LANs) together, so that users and computers in one location can 
communicate with users and computers in other locations. 

WWAN 
Wireless Wide Area Network (WWAN). Also called “wireless 
broadband” or “broadband wireless,” wireless WANs (WWANs) 
use cellular towers to transmit a wireless signal over a range of 
several miles to a mobile device. Compare to wireless Wi-Fi LANs 
(WLANs), which span only a few hundred feet and generally only 
to stationary devices. 

Glossary: U-W


	Configure
& Connect
	Overview 
	Using the MobiLink Connection Manager
	Managing Connectivity from the Connection Manager

	Using the system tray icon 
	Managing Connectivity from the MobiLink System Tray icon

	Using the MobiLink menus
	Settings
	Languages
	Activation
	Device Properties
	SMS Client
	Address Book
	GPS
	About
	SMS 
messaging

	Overview
	Compose and Send Messages
	Use the Format menu
	Select Recipients from Your Address Book
	Send an SMS message from the Address Book
	Troubleshooting

	Troubleshooting
	Glossary




